SAS® Enterprise Miner™ 14.2: Administration and Configuration
## Contents

**Chapter 1 • SAS Enterprise Miner Administration and Configuration Guide Overview** .......................................................... 1
  - SAS Enterprise Miner .................................................. 1
  - Intended Audience .................................................... 2
  - Organization of This Document ..................................... 2
  - SAS Information Online .............................................. 3
  - Related SAS Software ................................................ 3

**Chapter 2 • The SAS Enterprise Miner Architecture** .......................................................... 5
  - Overview of the SAS Enterprise Miner Architecture .......... 5
  - SAS Enterprise Miner Components ................................ 7
  - SAS Enterprise Miner Deployment ................................ 8

**Chapter 3 • System Requirements** .......................................................... 11
  - System Requirements Overview .................................. 11
  - Supported Operating Systems ..................................... 12
  - Software for SAS Enterprise Miner ................................. 13
  - Data Access Requirements ......................................... 14
  - System Setup and Performance ................................... 14

**Chapter 4 • Migrating to SAS Enterprise Miner 14.2** .......................................................... 15
  - Migration Overview .................................................. 15
  - Updating WebDAV Paths ............................................. 15
  - Project Migration Macros ........................................... 17

**Chapter 5 • SAS Enterprise Miner Server Installation and Configuration** .......................................................... 19
  - Installation Overview ................................................ 19
  - Pre-Installation Tasks ................................................ 21
  - Install and Configure SAS Enterprise Miner ....................... 25
  - Deployment Errors and Warnings ................................ 35
  - Verify the Installation ................................................ 36

**Chapter 6 • SAS Enterprise Miner Workstation Installation and Configuration** .......................................................... 45
  - SAS Enterprise Miner Workstation Deployment ................. 45

**Chapter 7 • Post-Installation Information** .......................................................... 47
  - About Post-Installation Tasks ..................................... 47
  - Configuration Guidelines and Details ............................. 47
  - Check for Current Hot Fixes ........................................ 48
  - Configure SAS Enterprise Miner in SAS Management Console 48
  - Define Additional SAS Enterprise Miner Users .................. 52
  - Create a SAS Environment File .................................... 55

**Chapter 8 • Administrative Tasks and Information** .......................................................... 57
  - SAS Enterprise Miner Overview for Administrators ............ 57
  - Publishing Extension Tools ........................................ 58
  - Troubleshooting ....................................................... 59
  - Adding a New Workspace Server for SAS Enterprise Miner .. 62
  - SAS Enterprise Miner Model Package Registration ............ 66
  - SAS Enterprise Miner Start Code ................................ 68
  - Defining Migrated Projects in SAS Enterprise Miner .......... 69
  - Configuring the Locale for Multi-Language Environments .... 71
Chapter 9 • Additional Configuration Options .................................................. 73
SAS Enterprise Miner with SAS Lockdown Mode ........................................... 73
Integrated Windows Authentication .............................................................. 75
SAS Enterprise Miner Mid-tier Server Clustering .......................................... 76
Chapter 1
SAS Enterprise Miner
Administration and Configuration
Guide Overview

SAS Enterprise Miner
Overview of SAS Enterprise Miner
Key Benefits of SAS Enterprise Miner

Intended Audience
Organization of This Document

SAS Information Online
Current Documentation
SAS Notes
SAS Technical Support Services
Product Help

Related SAS Software
Base SAS
SAS Credit Scoring for SAS Enterprise Miner
SAS Text Miner
SAS Enterprise Guide
SAS/STAT
SAS/GRAPH

SAS Enterprise Miner

Overview of SAS Enterprise Miner

SAS Enterprise Miner is a flexible and powerful data mining package designed to streamline the data mining process. SAS Enterprise Miner creates highly accurate predictive and descriptive models based on vast amounts of data that is gathered by an organization. It offers a rich, easy-to-use set of integrated capabilities to create and share insights that are used to drive decisions faster and more accurately.

Key Benefits of SAS Enterprise Miner

The following are just a few of the benefits that are provided by SAS Enterprise Miner:

• improved model performance and accuracy through superior analytic data preparation techniques and innovative algorithms
• an easy-to-use interface that helps both business analysts and statisticians build better models in less time
• the ability to derive and share insights that improve the quality and precision of the resulting decisions
• a broad set of tools to support an efficient, integrated data mining process

Intended Audience

This administrator’s guide describes the recommended system architecture and requirements, installation and post-installation tasks, ongoing system administration, and troubleshooting. The SAS Enterprise Miner Administrator’s Guide is for administrators who need to install, configure, and optimize SAS Enterprise Miner. No programming experience, SAS or otherwise, is necessary to administer SAS Enterprise Miner.

The administration duties are divided into two roles, a system administrator and a SAS Enterprise Miner administrator. These do not need to be the same person.

• The system administrator must be familiar with the hardware, operating system, file system, installed applications, maintenance, and operation of the computer system that will house SAS Enterprise Miner.
• The SAS Enterprise Miner administrator must be familiar with the installation, configuration, and maintenance of all parts of the SAS system, including the SAS Metadata Server. One such duty is the maintenance of the metadata server, which regulates traffic between servers, users, and other global resources required by SAS Enterprise Miner.

Organization of This Document

This administrator’s guide is organized in the following manner:

• Overview — introduces you to your SAS solution, explains how the guide is organized and presented, and provides additional resources for you to explore, should you need more information about your SAS solution software. It also provides a quick overview of the SAS Intelligence Platform and how your SAS solution integrates into the SAS Intelligence Platform.
• System Requirements — describes the environment, hardware, software, data, and network requirements for implementing your SAS solution.
• Installation and Configuration — provides an overview of the planned installations and software index installations. It also provides post installation tasks and a process for verifying a successful installation and configuration of your SAS solution.
• Administration — discusses the necessary system administration tasks, such as administration security that your SAS solution requires.
• Glossary — contains terminology related to SAS Enterprise Miner.
SAS Information Online

Current Documentation
For the most current installation and configuration information for SAS Enterprise Miner, see http://support.sas.com/documentation/onlinedoc.

SAS Notes
For additional information and support fixes, you should check the SAS Notes that are available on the SAS Technical Support website. You can search for available SAS Notes for SAS Enterprise Miner at http://support.sas.com/software/products/miner/index.html.

SAS Technical Support Services
The SAS Technical Support staff is available to respond to problems and answer technical questions.

Product Help
For in-depth information about how to operate your software and its features, select the Help menu item from within SAS Enterprise Miner.

Related SAS Software

Base SAS
Base SAS delivers a highly flexible and extensible fourth-generation programming language that is specially designed for data access, transformation, and reporting. It includes a rich library of encapsulated programming procedures for data manipulation, information storage and retrieval, descriptive statistics, and report writing.

SAS Credit Scoring for SAS Enterprise Miner
SAS Credit Scoring for SAS Enterprise Miner supports the process of building credit scoring models inside the SAS Enterprise Miner environment. The end result is a credit scorecard that assigns points based on customer attributes. The total number of points is used to determine the credit policy that a lender will offer. SAS Credit Scoring for SAS Enterprise Miner includes new add-in nodes: Interactive Grouping, Scorecard, Reject Inference, and Credit Exchange. SAS Credit Scoring for SAS Enterprise Miner is also a component of the larger BIS Credit Risk Management solution, including SAS Risk Dimensions, which can read credit scorecard models as input to the risk optimization models.

The SAS Credit Scoring for SAS Enterprise Miner solution is not included with the base version of SAS Enterprise Miner. If your site has not licensed SAS Credit Scoring for
SAS Enterprise Miner, the credit scoring node tools do not appear in your SAS Enterprise Miner software.

**SAS Text Miner**

SAS Text Miner provides tools that enable you to extract information from a collection of text documents and uncover the themes and concepts that are revealed therein. In addition, because you can embed SAS Text Miner nodes in a SAS Enterprise Miner process flow diagram, you can combine quantitative variables with unstructured text in the mining process and thereby incorporate text mining with other traditional data mining techniques.

SAS Text Miner is not included with the base version of SAS Enterprise Miner. If your site has not licensed SAS Text Miner, then the text mining nodes do not appear in your SAS Enterprise Miner software.

**SAS Enterprise Guide**

SAS Enterprise Guide is an easy-to-use, project-oriented Windows application that provides access to the analytic power of SAS. Business analysts, statisticians, and SAS programmers can gather and manage the data that they need, and perform meaningful analyses quickly. The point-and-click interface guides users through the analytical process and makes it easy to create reports, graphs and charts, and to deliver the results throughout the organization.

**SAS/STAT**

SAS/STAT software provides organizations with access to the most up-to-date statistical techniques including extensive capabilities for both specialized and enterprise-wide analytic needs.

It is designed to handle vast amounts of disparate data from a variety of sources, all with the aim of providing the most reliable analysis available. In delivering these capabilities, SAS/STAT provides extensive statistical capabilities for both specialized and enterprise-wide analytical needs, helping you analyze data and make informed decisions for research, engineering, manufacturing, medical, government, academic, and business applications.

**SAS/GRAPH**

SAS/GRAPH provides high-impact visuals to all levels of your organization, giving customers a quick and easy understanding of information and empowering them to make informed, timely decisions. SAS/GRAPH software extends the power of data management, business intelligence, and analytic tools, enabling customers to turn data into eye-catching, full-color graphs and charts in seconds.
Chapter 2
The SAS Enterprise Miner Architecture

Overview of the SAS Enterprise Miner Architecture

Architecture

The SAS Enterprise Miner is integrated with the SAS Intelligence Platform. The SAS Intelligence Platform architecture is designed to efficiently access large amounts of data, while simultaneously providing timely intelligence to a large number of users. The platform uses an n-tier architecture that enables you to distribute functionality across computer resources, so that each type of work is performed by the resources that are most appropriate for the job. For more information about the SAS Intelligence Platform, see SAS 9.4 Intelligence Platform: Overview.
The following is an overview of the SAS Intelligence Platform.

**The SAS Intelligence Platform: SAS Metadata Server**

The SAS Metadata Server controls access to a central repository of metadata that is shared by all of the SAS applications in the deployment. The SAS Metadata Server enables centralized control so that all users access consistent and accurate data. SAS Enterprise Miner stores metadata concerning users, data mining projects, and other resources in the repository. Administrators use SAS Management Console to administer the SAS Metadata Server, including SAS server configurations. SAS Enterprise Miner can also use the SAS Metadata Server to obtain metadata about SAS libraries, SAS Workspace Servers, and the SAS Object Spawner and to authenticate users.

**The SAS Intelligence Platform: SAS Workspace Server**

The SAS Workspace Server enables client applications to submit SAS code to a SAS session using an application programming interface (API). SAS Enterprise Miner generates the SAS code necessary to perform the processing and submits it to a workspace server. You can run as many instances of workspace servers as are needed to support your workload.

**The SAS Intelligence Platform: The SAS Object Spawner**

The SAS Object Spawner is the process that SAS Enterprise Miner uses to run the workspace server. It listens for requests for a server, authenticates the requesting client, and launches the server process as needed. The SAS Object Spawner connects to the SAS Metadata Server to obtain information about the servers that it manages.

**SAS Web Infrastructure Platform**

The SAS Web Infrastructure Platform (or WIP) provides the primary middle-tier components for the SAS platform. It supports n-tier architectures built around HTTP-based technologies. The middle-tier components in WIP not only provide for common
infrastructure, but also support distributed deployments and configurations that support enterprise requirements.

The SAS Web Infrastructure Data Server is a database server that is used by the SAS Web Infrastructure Platform as the default location for middle-tier data. This data includes alerts, comments, and workflows.

---

**SAS Enterprise Miner Components**

**SAS Enterprise Miner Server**

The SAS Enterprise Miner Server offers an extensive and extensible set of tools. These tools streamline the data mining process and create highly accurate predictive and descriptive models based on the analysis of vast amounts of data from across an enterprise. SAS Enterprise Miner enables you to develop data mining flows that consist of data exploration, data transformations, and modeling tools to predict or classify business outcomes. It is accessible through both the SAS Enterprise Miner client and SAS Enterprise Miner batch processing.

**SAS Enterprise Miner Middle Tier**

The middle tier of SAS Enterprise Miner provides an environment through which the SAS Enterprise Miner client can send and receive data through standard web protocols (that is, HTTP or HTTPS). This data is routed via the SAS Web Infrastructure Platform to and from servers on the SAS server tier. On the SAS server tier, the data is processed, queried, and analyzed.

**SAS Enterprise Miner Client**

The SAS Enterprise Miner client is a powerful and intuitive user interface that streamlines access to the data mining tools available in the SAS Enterprise Miner server.

**SAS Enterprise Miner Workstation**

The SAS Enterprise Miner Workstation is a stand-alone component that is a combination of parts of the server, middle tier, and client components that provides much of the functionality of the other components, but requires no configuration. It is applicable only to a single-user Windows system.

**SAS Enterprise Miner Plug-in for SAS Management Console**

The SAS Enterprise Miner Plug-in for SAS Management Console enables you to browse and customize some of the metadata objects that SAS Enterprise Miner uses. The SAS Enterprise Miner Plug-in provides access to attributes of the Logical Workspace server and server-specific project entries. The SAS Enterprise Miner Plug-in also provides access to the list of mining result packages that have been registered via SAS Enterprise Miner.
SAS Enterprise Miner Deployment

Overview

There are two basic types of deployment for SAS Enterprise Miner: workstation and client/server.

Workstation deployments are available only for Microsoft Windows systems and are strictly single-user configurations. This deployment does not require the deployment plan or a configuration step of the SAS Deployment Wizard. The workstation mode configuration does not require the SAS Metadata Server or the SAS Application Server. This configuration is intended for SAS Enterprise Miner Desktop, SAS Enterprise Miner Classroom, and SAS Enterprise Miner Workstation licenses.

In client/server mode, SAS Foundation 9.4 and SAS Enterprise Miner 14.2 server can be installed on a local or remote system for multi-user access. The SAS Web Infrastructure Platform is installed for the SAS Enterprise Miner 14.2 middle tier. In previous releases, the middle tier used the SAS Analytics Platform. In this release, that support is provided by the SAS Web Infrastructure Platform, SAS Web Application Server, and the SAS Web Server. The SAS Enterprise Miner middle tier can be installed either on a local or remote machine, but it requires a 64-bit system. The SAS Enterprise Miner 14.2 client can be installed and started on a Microsoft Windows system, or it can be started through Java Web Start by connecting through your Internet browser to the SAS Enterprise Miner 14.2 middle tier.

SAS Enterprise Miner Client/Server Deployment

This deployment serves the needs of a multi-user server, and a single user requiring a full SAS Intelligence Platform environment.

The client/server deployment requires the following:

- SAS Web Infrastructure Platform, and its requirements
  - SAS Metadata Server
  - SAS Object Spawner
  - SAS Web Infrastructure Data Server
  - SAS Web Application Server
  - SAS Web Server
  - SAS Enterprise Miner, which includes the SAS Enterprise Miner server, SAS Enterprise Miner middle tier, and SAS Enterprise Miner client

SAS Enterprise Miner Client-Only Deployment

This deployment serves the needs of an end user who needs to connect to a remote server, but chooses not to use Java Web Start.

The client-only deployment requires the following:

- SAS Enterprise Miner client
• the Java Runtime Environment (JRE) provided by SAS

It does not require the following:
• SAS Deployment Wizard configuration
• local metadata services

**SAS Enterprise Miner Workstation Deployment**

This deployment serves the needs of the following users:
• those that do not require the full SAS Intelligence Platform environment
• full SAS Enterprise Miner client users
• SAS Enterprise Miner Desktop users
• SAS Enterprise Miner Classroom users

The Workstation deployment requires the following:
• the Java Runtime Environment (JRE) provided by SAS
• SAS Enterprise Miner Workstation, Desktop, or Classroom, each of which includes the SAS Enterprise Miner client

The workstation configuration does not require installation or configuration for a SAS Web Application Server, SAS Object Spawner, SAS Web Infrastructure Data Server, or SAS Metadata Server. However, the workstation configuration does not support SAS grid processing or operating systems other than Windows.

The workstation configuration supports the following:
• connections to a SAS Metadata Server for model registration, browsing, and deletion
• Windows 7 and Windows 8
Chapter 3
System Requirements

System Requirements Overview

Overview

The following system requirements are generalized estimates for SAS Enterprise Miner. For a more accurate description of the requirements for your specific system and software use the documentation found at http://support.sas.com/resources/sysreq.

Hard Disk Space

The SAS Enterprise Miner server installation uses approximately 23 gigabytes of hard disk space. The SAS Enterprise Miner client installation uses approximately 2 gigabytes of hard disk space. The SAS Enterprise Miner Workstation installation uses approximately 4 gigabytes of hard disk space.

Disk space requirements for data should be analyzed for both the client and server machines.
In addition to the amount of disk space needed to install SAS Enterprise Miner, you will need adequate disk space to store the following:

- the data to be mined. You must provide space for the source data, whether it is SAS data sets or RDBMS tables.
- the work data that is generated during SAS Enterprise Miner processing on the server. A general recommendation is for each project to allow for four to seven times the amount of the data file being analyzed.

The SAS Enterprise Miner Sample, Data Partition, and Memory-Based Reasoning nodes create work files that are as large as the input data files during execution. If your data analyses use these nodes regularly, plan your disk space allocation accordingly.


**RAM**

The SAS Enterprise Miner server requires 6 gigabytes of memory, plus 2 gigabytes per concurrent user. The SAS Enterprise Miner client requires a minimum of 4 gigabytes of available RAM. The mid-tier requires 8 gigabytes of memory. Therefore, a single machine installation would require a minimum of 18 gigabytes of memory.

**CPU**

In general, you should have one or more CPUs or processor cores available per user. More specifically, if you expect to take advantage of the SAS Enterprise Miner parallel processing or multithreading capabilities, a minimum of one processor core is required per running node. System performance degrades precipitously when nodes compete for CPU resources. Beyond that, the number of CPUs or processor cores needed to optimize performance for SAS Enterprise Miner on your system is difficult to specify. Factors such as the size of your data, I/O subsystems, the number of concurrent users, the CPU make and model, and your network infrastructure can affect the apparent performance of any system.

**Pathnames**

It is strongly recommended that SAS Enterprise Miner pathnames are relatively short and contain no spaces or special characters other than the underscore. Pathnames that are excessively long, contain spaces, or contain special character are known to cause run-time errors.

**Supported Operating Systems**

The SAS Enterprise Miner server, middle tier, and workstation components are supported on the following operating systems:

- 32- and 64-bit Windows systems, including Windows 7, and Windows Server 2008
- AIX (power)
Software for SAS Enterprise Miner

Third-Party Software Requirements

In addition to the licensed SAS products required to support SAS Enterprise Miner, some third-party software is required. The SAS Enterprise Miner middle tier requires Windows PowerShell 2.0. The SAS Enterprise Miner Server installation and the SAS Enterprise Miner Workstation require only the Java Runtime Environment (JRE) that is included during the installation. For information about third-party software and to access downloads of the software, see http://support.sas.com/resources/thirdpartysupport/v94/index.html.

Note: PowerShell is a Windows-only requirement.

Included SAS Software

The software installed with the SAS Enterprise Miner server includes licenses for the following powerful SAS products that can be useful in your organization for data analysis, sharing, scoring, and reporting:

- Base SAS
- SAS/CONNECT
- SAS/GRAPH
- SAS Integration Technologies
- SAS/STAT
- SAS Enterprise Guide

In addition to these products, the high-performance data mining nodes are now available to all SAS Enterprise Miner users. The high-performance data mining nodes perform threaded parallel processing for both the desktop and server installations of SAS Enterprise Miner.

Optional SAS Software

A large number of SAS products and components are not part of the basic software bundle can be used in conjunction with SAS Enterprise Miner.

• HP-UX IPF
• Linux for x86 and x64
• Solaris (SPARC)
• Solaris for x64

The SAS Middle-Tier is supported on all of the 64-bit systems listed above except for the HP-UX for x64.

The SAS Enterprise Miner client is an application based on Java that can be installed only on Windows workstations (32- or 64-bit). However, the SAS Enterprise Miner client is accessible via Java Web Start on any of the supported operating systems listed above.

Note: PowerShell is a Windows-only requirement.
Some of the more popular optional products include the following:

- SAS High-Performance Data Mining
- SAS High-Performance Text Mining
- SAS Text Miner
- Credit Scoring for SAS Enterprise Miner
- SAS/ACCESS product for your database
- SAS Analytics Accelerator for Teradata
- SAS Accelerator Publishing Agent
- SAS Model Manager
- SAS BI Server

---

**Data Access Requirements**

Most organizations have data strewn across a large number of heterogeneous data sources. SAS Enterprise Miner leverages the extremely powerful data access, manipulation, and management capabilities of the SAS 9.4 Intelligence Platform. The SAS 9.4 Intelligence Platform provides data access that is unmatched in the number of sources and the ease with which data can be accessed and assembled in one environment.


---

**System Setup and Performance**

For information about preparing your system and improving system performance, see the SAS 9.4 Intelligence Platform: System Administration Guide. Pay particular attention to the section about best practices for configuring the middle tier in the web Application Administration Guide of the SAS Intelligence Platform documentation at [http://support.sas.com/documentation](http://support.sas.com/documentation).
Migration Overview

SAS Enterprise Miner projects are composed primarily of physical files and metadata about the projects and data sources. If you are upgrading your current system, you need to migrate only the metadata from your previous system to your new system. If you are changing operating systems, you also need to migrate the physical files for your projects and data sources.

Migrating to a new server, a new operating system, or a new SAS topology requires more care and planning. You should review your goals for upgrading and develop an upgrade plan that best fits your enterprise environment. The *SAS 9.4 Intelligence Platform: Migration Guide* explains the options available, defines the steps required both before and after installation of your new software. For metadata migration, follow the *SAS 9.4 Intelligence Platform: Migration Guide*.

For more information about system migration, see the SAS Technical Support’s focus area for Migration at [http://support.sas.com/rnd/migration](http://support.sas.com/rnd/migration).

Using the SAS Migration Utility with the SAS Deployment Wizard to migrate to SAS 9.4 has the advantage of being the most automated process available.

If circumstances prevent you from migrating your old system’s metadata during the installation of your new SAS system, you can manually define new metadata for migrated projects. See Defining Migrated Projects in SAS Enterprise Miner on page 69 for more information.

Updating WebDAV Paths

If you published SAS Enterprise Miner model packages to a WebDAV server, then you might need to manually update the WebDAV path. You can use the SAS Management Console to update the WebDAV URL prompt for all SAS Enterprise Miner Logical Workspace servers that log on to the SAS Management Console with an administrative
account. In the SAS Management Console, complete the steps below to manually update the WebDAV URL.

1. In the **Plug-ins** tab, expand the **Application Management** folder, then the **Enterprise Miner** folder, and then the **Projects** folder.

   ![SAS Management Console](image)

   2. In the **Projects** folder, right-click a Logical Workspace Server and select **Properties**.

   3. In the Logical Workspace Server Properties window, select the **Options** tab. Update the URL in the **WebDAV URL** field to the correct location.
4. Repeat steps 2 and 3 for every Logical Workspace Server in the Projects folder.

For more information, see SAS Enterprise Miner Plug-in for SAS Management Console in the SAS Enterprise Miner Reference Help.

Project Migration Macros

The physical files and folders that make up a SAS Enterprise Miner project can be numerous and complicated in structure. When moving the project files, the hierarchy of folders and files needs to be maintained. If you are migrating to an operating system with a different word size (32-bit to 64-bit), a different locale or encoding, or different byte order, you need to convert the SAS Enterprise Miner project files to a format compatible with your new operating system.

On the previous system, the EM_MigrateProject macro can be used to prepare SAS Enterprise Miner project directories and files for movement between different operating environments. For example, moving SAS Enterprise Miner projects to or from 32-bit and 64-bit systems (such as moving from Windows Server 2003 32-bit environment to a Windows Server 2008 64-bit environment) requires the EM_MigrateProject macro. If you are changing to a system with a different locale and encoding from your previous system, you need the EM_MigrateProject macro. If you are changing from one operating
system to a different SAS Enterprise Miner supported operating systems, such as moving HP-UX files to a Red Hat Linux operating environment, the EM_MigrateProject macro is needed.

On the new system, the EM_MigrateProject macro restores prepared projects to a usable form after the directories and files are moved to the new system. The EM_MigrateProject macro and its user’s guide are available from the SAS Technical Support’s Download site, [http://support.sas.com/demosdownloads/sysdep_t1.jsp?packageID=000726](http://support.sas.com/demosdownloads/sysdep_t1.jsp?packageID=000726).

Information about migrating your other SAS files to a new system is available in the SAS System Help under Strategies for Moving and Accessing SAS Files.
Chapter 5
SAS Enterprise Miner Server
Installation and Configuration

**Installation Overview**

**Introduction**

There are two basic modes of operation in SAS Enterprise Miner: the SAS Enterprise Miner server and the SAS Enterprise Miner workstation. For large enterprises with multiple users, SAS Enterprise Miner server provides the scalability and connectivity needed. For situations where a server-based installation is not required, the SAS
Enterprise Miner workstation installation supports a single-user, single-machine installation.

In server mode, SAS Intelligence Platform 9.4 and the SAS Enterprise Miner 14.2 server can be installed on a local or remote system for multi-user access. The SAS Web Infrastructure Platform is installed as a mid-tier server. The SAS Enterprise Miner 14.2 client can be installed on a Microsoft Windows system, or can be started through Java Web Start by connecting your Internet browser to the SAS middle tier.

In workstation mode, SAS Intelligence Platform 9.4 and SAS Enterprise Miner 14.2 are deployed on a Microsoft Windows system in a single-user configuration. This configuration is indicated for SAS Enterprise Miner Desktop, SAS Enterprise Miner Classroom, and SAS Enterprise Miner workstation licenses. This deployment does not require a plan file, a SAS Web Application Server, or the configuration step required in a server installation. Customers with workstation, Desktop, or Classroom licenses use the non-planned installation by default. Customers with a server license who want to take advantage of the workstation installation can install SAS Foundation and related products and will then be on the same path.

**Deployment Outline**

To install and deploy the SAS Enterprise Miner server, you must perform the following tasks:

1. Work with your SAS representative to develop a plan and designate the host machines for your deployment of SAS Enterprise Miner.

2. If you are upgrading from a previous release, read the Upgrade and Migration Information in the preceding chapter.

3. Read the SAS Intelligence Platform documentation, and complete the pre-installation tasks.

4. Complete the pre-installation tasks for SAS Enterprise Miner.

5. Install SAS Intelligence Platform and SAS Enterprise Miner on each host machine as outlined in your plan.xml file that you developed with your SAS representative.


**SAS Intelligence Platform Documentation**

Because SAS Enterprise Miner is integrated with the SAS Intelligence Platform, it is recommended that you read the SAS Intelligence Platform documentation before you install SAS Enterprise Miner. This documentation is located at http://support.sas.com/documentation/onlinedoc/intellplatform/index.html. The supporting documentation provides pre-installation tasks and instructions to guide you through a typical installation of the SAS Intelligence Platform. Referenced in this document are the following:


Default File Locations

The SAS Deployment Wizard installs and configures your SAS software. The application installation files are installed in a default location referred to as SAS_HOME. For example, on a Windows system, SASHome is \Program Files\SAS.

The configuration files are stored in a default location referred to as the <config-dir>. For example, on a Windows system, the <config-dir> is \Config\Lev<number>.

Note: You can deploy up to ten configurations of the SAS products. The SAS Deployment Wizard specifies each configuration under a Lev<number> folder. For example, if you deploy a level-2 configuration, then the default configuration directory is \Config\Lev2.

The table below shows the default location of the installation and configuration files for SAS Enterprise Miner.

<table>
<thead>
<tr>
<th>Locations</th>
<th>Windows Systems</th>
<th>UNIX Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS_HOME</td>
<td>\Program Files\SASHome</td>
<td>/usr/local/SASHome</td>
</tr>
<tr>
<td>!SASROOT</td>
<td>\Program Files\SASHome\SASFoundation\9.4</td>
<td>/usr/local/SASHome/SASFoundation/9.4</td>
</tr>
<tr>
<td>config-dir</td>
<td>\Config\Lev1</td>
<td>/usr/local/config/Lev1</td>
</tr>
</tbody>
</table>

Pre-Installation Tasks

Overview

Before you begin your installation of SAS Enterprise Miner, you must complete the following tasks:

1. Create the Deployment Plan files.
2. Create a SAS Software Depot.
3. Review additional documentation.
4. Prepare your computer systems.
5. Designate ports.
7. Install required third-party software.

**Deployment Plan**

When you and your SAS representative initially plan the deployment of SAS Enterprise Miner, your SAS representative will record your decisions about which software you will deploy and on which hardware that software will be installed. This information is used to generate a deployment plan file.

A deployment plan is an XML file that is used as input to the SAS Deployment Wizard. There are two types of deployment plans: standard and custom. A standard deployment plan describes a common configuration. Standard deployment plans are stored by default in the SAS Software Depot. A custom deployment plan is created by a SAS representative specifically for a site.

If your environment requires a custom plan, SAS sends you an email message with either a set of files or a ZIP file that has a set of files. Those files include the following:

- The Deployment file (plan.xml) — This is one of the key files in the SAS Project Directory that is used throughout the rest of the deployment process to customize your installation and configuration experience. The plan.xml file serves as input to the SAS Deployment Wizard. Copy this set of files to the plan_files folder in the top level of the SAS Software Depot.
- The Pre-Installation Checklist (checklist.pdf or checklist.rtf) — This is where you record information such as the credentials for special SAS users, machine names, ports, and the installation locations of third-party products relevant to your deployment.
- The Index file (index.html) — This file provides some high-level guidance through the remainder of the process. The index.html file includes a reference to a pre-installation checklist, which is for the items that you need to know for the remainder of the process. Information that you enter in the checklist is requested in later stages of the installation process. It is important that you record the information for later use as an aid in consistency and documentation of decisions that you made.


**Create a SAS Software Depot**

When you download a SAS order, the SAS Download Manager automatically creates a SAS Software Depot on your system. For more details about creating your software depot, see “Creating a SAS Software Depot” in the *SAS 9.4 Intelligence Platform: Installation and Configuration Guide*.

**Additional Documentation**

The *SAS 9.4 Intelligence Platform: Installation and Configuration Guide* provides detailed information related to all installations that include all or part of the SAS 9.4 Intelligence Platform, including SAS Enterprise Miner. SAS Enterprise Miner is bundled with several other SAS products that are not covered in detail by this guide. It is important that you become familiar with the *SAS 9.4 Intelligence Platform: Installation and Configuration Guide*.

You should also familiarize yourself with the following:
System Preparations

As a pre-installation task, you must designate or create a domain account that will act as the SAS Installer. This account will require administrative operating system privileges on each machine that hosts the SAS Enterprise Miner server, a SAS Workspace server, or SAS Enterprise Miner project files. On a Windows system, this account also requires the permissions log on as a batch job and Access this computer from the network. The logon permission permits the user to be logged on by means of a batch-queue. You can configure this security setting by opening the appropriate policy and adding each account. Generally, it is recommended that you create a user group, and give the group the Log on as a batch job, and, if necessary, the Access this computer from the network permission. Then, add each account to that group. For UNIX, the SAS Installer account should not be the root account.

The Access this computer from the network permission is also required in order to connect to SAS servers. Typically, this right is already granted to the Windows group Everyone. To confirm, check the Windows local policy settings.

The SAS Enterprise Miner server uses both regular user accounts and product administrative user accounts. You can create regular user accounts for the SAS Enterprise Miner as a post-installation task. For more information, see Define Additional Enterprise Miner Users on page 52 in Chapter 7.

Note that a product administrator account is not the same as a SAS internal administrator account, such as the SAS Administrator (sasadm@saspw).

Designate Ports

The communications between the components of SAS Enterprise Miner require a number of ports that must be designated during the installation process. Consult the pre-installation checklist that is provided by your SAS representative for a complete list of ports that you must designate. The SAS 9.4 Intelligence Platform: Installation and Configuration Guide has more information about port requirements and selection in the “Setting Up Users, Groups, and Ports.”

The SAS Environment File

A SAS environment file defines the available set of SAS environments for the SAS Enterprise Miner server’s client applications, and is generated during the configuration of the SAS Web Infrastructure Platform. This step is carried out by the SAS Deployment manager when you install the SAS Enterprise Miner server. The SAS Logon Manager includes a servlet that provides default information for the initial deployment.

When you have validated that your client applications work successfully with a deployment, it is recommended that you deploy the sas-environment.xml file to an HTTP server. This step ensures that you can customize the sas-environment.xml file to specify the name that you want to use and to account for the IT topology at your site. Your site might require that application clients interact with separate development, test, and production environments. Or, you might choose to have separate SAS deployments.
to support distinct business units. In either scenario, when multiple environments are required, you can customize and deploy the sas-environment.xml file as needed.

Before starting the SAS Enterprise Miner server installation, you must determine the URL that is needed to access the default installation sas-environment.xml. The URL to access the default environment definition would be http://<host>:<port>/sas/sas-environment.xml. For example, if you are running a SAS Application Server on your desktop, you can deploy the default sas-environment.xml file at http://localhost:80/sas/sas-environment.xml.

For the SAS Enterprise Miner server the default URL would resemble the following: http://myserver.mynet.mycompany.com:80/sas/sas-environment.xml.

For more details about the SAS environment file and how to configure SAS environments pre- or post-installation see the SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide.

Note: An HTTP server is included with most installation plans. If you configured the SAS Web Server, then you do not need to deploy the SAS environment file.

**Third-Party Software Required for SAS Enterprise Miner Server**

SAS Enterprise Miner server installation uses an included JRE. For SAS 9.4, you must use JRE 1.7.0_17, or later versions. The SAS Enterprise Miner server installation requires Windows PowerShell 2.0. You can determine the version of PowerShell by opening the Windows PowerShell command prompt and entering $PSVersionTable.

Note: PowerShell is required only for Windows environments.

When installing SAS Enterprise Miner, you must provide valid paths to the required third-party software, or the SAS Deployment Wizard will not let you continue with the SAS Enterprise Miner server installation. For information about required versions of third-party software, see the Third-Party Software for SAS 9.4 available from the SAS Support Install Center, located at [http://support.sas.com/resources/thirdpartysupport/](http://support.sas.com/resources/thirdpartysupport/).

**SAS Text Miner and the SAS Document Conversion Service**

Installations that include SAS Text Miner will be prompted for the host and port for SAS Document Conversion service. SAS Document Conversion runs on both Windows and UNIX platforms. It works with any version of Microsoft Windows that supports Microsoft .NET Framework and can run 32-bit applications. This includes any 64-bit versions of Microsoft Windows that run in compatibility mode. On both platforms, when SAS Enterprise Miner and SAS Text Miner are installed, SAS Document Conversion is installed on the same machine automatically.

SAS Text Miner uses the SAS Document Conversion server to extract plain text from proprietary file formats such as PDF and Microsoft Word so that the text can be analyzed by SAS Text Miner. The SAS Text Miner components communicate with the document conversion service over the network. The SAS Document Conversion readme file in the SAS Software Depot provides additional information.
Install and Configure SAS Enterprise Miner

Overview

For the best overall explanation of the installation and configuration of the numerous combinations of products and environments, see the SAS 9.4 Intelligence Platform Installation and Configuration Guide.


In the following sections, step-by-step examples of both server and workstation mode deployments are provided to give you a better idea about what to expect when you install SAS Enterprise Miner.

SAS Enterprise Miner Server Multiple Machine Deployment

Deployment Information

A server deployment of SAS Enterprise Miner begins when you and your SAS representative decide which software you need, determine which machines to install the software on, and develop your installation plan. Each server deployment requires a plan. In this example, one of the standard deployment plans included in your SAS software is used to illustrate some of the options available during a SAS Enterprise Miner server deployment.

The plan “EMiner, TMiner, three machines” will install the server, mid-tier, and client on three separate network machines. The plan uses the included SAS Application Server on the mid-tier machine. For this example, you need three separate machines on your network. You need to prepare all three systems and complete the pre-installation tasks on each machine.

Three Machine Setup, Stage 1 — Server

1. Log on to the computer that will be the SAS Enterprise Miner server machine. Start the SAS Deployment Wizard from the highest-level directory in your SAS Software Depot with the setup application that is appropriate to your operating system. For this example, on a 64–bit Windows system, double-click the setup.exe file located in the SAS Software Depot folder.

2. Select your preferred language for the SAS Deployment Wizard. Click OK.

3. The SAS Deployment Wizard opens.
   a. Select Install SAS Software under End User Tasks. Click Next.
   b. Specify SAS Home — Choose a file system location to use as the home folder for your SAS software. On Windows systems, the home folder location defaults to C:\Program Files\SASHome. You can use the Browse button to navigate to an alternate location for the SASHome folder. Click Next.
   c. Select Deployment Type — The default installation selects Perform a Planned Deployment, Install SAS Software, and Configure SAS Software. Click Next.
d. Specify Deployment Plan — Choose **Select a standard deployment plan** and select **EMiner, TMiner, three machines**. If your SAS representative provided you with a custom plan file, select **Specify the full path to a customized deployment plan**. This is the **plan.xml** file. Typically, the deployment plan is stored in the **plan_files** folder of the SAS Software Depot. If necessary, click **Browse** to navigate to your **plan.xml** file. Click **Next**.

e. Select Deployment Step and Products to Install — Select **Step 1: Server** in the **Deployment Step** drop-down menu. Click **Next**.

![SAS Deployment Wizard](image)

f. Specify SAS Installation Data File — This is where you enter the path to your SID file. By default, the SID file is located in the SAS Software Depot, under the **sid_files** folder. If necessary, click **Browse** to navigate to this file. Click **Next**.

g. Select Language Support — Select the languages that you want to install for any products that are listed. Only those languages that are compatible with your locale are installed. Click **Next**.

h. Select Regional Settings — Use this window to determine the format and display of language-, region-, and locale-specific information. You can choose to configure SAS as a Unicode server, and force SAS to use UTF-8 encoding in all data sets, catalogs, and text that is written by SAS. This is useful if you need to share files with computers that use a different locale setting than your own. Click **Next**.

i. Specify SAS Clinical Standards Toolkit Libraries — Use the default values. Click **Next**.

j. Specify Environments URL — Specify a **SAS Environments URL** in the form of `http://localhost.localdomain:80/sas/sas-environment.xml` where localhost.localdomain is the current machine.

k. SAS Document Conversion Host and Port — Use this window to specify the local host and port. The default value is 7111. Click **Next**.

l. Specify Remote Communication Configuration — Use the default value of 5660. Click **Next**.
At this point, the installer will check the machine in preparation of deployment. When it becomes available, click **Next**.

4. The following information is needed to configure your SAS software:

   a. Select Configuration Prompting Level — Accept the default selection of **Typical**. Click **Next**.

   b. Specify Configuration Information — This step creates your software’s configuration directory. The SAS Deployment Wizard can allocate up to 10 configuration levels, and the default directory is `C:\SAS\EMTM`. The default **Configuration Level** is **Lev1**. This configuration is saved in `C:\SAS\EMTM\Lev1`. Click **Next**.

   c. Local Machine Name — Specify the **Fully Qualified Local Host Name** and the **Short Local Host Name**. Click **Next**.

   d. Migration Information — You can use this step to migrate existing content. However, there is no existing content for this example. Click **Next**.

   e. Integrated Windows Authentication — The default setting does not use Integrated Windows Authentication.

   f. Token Based Authentication — This installation does not use token-based authentication. Click **Next**.

5. SAS server configuration: Accounts

   a. SAS Metadata Server — Specify the **Host Name** and **Port** for your SAS Metadata Server. Click **Next**.

   b. SAS Metadata Server: Override Backup Location — This window enables you to change the server backup location. Accept the default location. Click **Next**.

   c. SAS Metadata Server: Override Service Login Account — The metadata server runs as a Windows service, and this page enables you to change the default credentials. Accept the default settings. Click **Next**.

   d. Deployment Accounts: Types of Accounts — This window enables you to specify the types of accounts that are used. Accept the default selection. Click **Next**.

   e. External Account: Installer — The default account will be your current user ID. Provide your password and click **Next**.

   f. SAS Internal Account: Unrestricted Administrator — Specify a password for the internal SAS administrator account. Click **Next**.

   g. SAS Internal Account: Trusted User — Specify a password for the internal SAS user sastrust. Click **Next**.

   h. External Account: SAS Spawned Servers Account — Specify the credentials of a local account for the SAS Spawned Servers. This account must reside on the installation machine. Click **Next**.

   i. Deployment Accounts: First User — Click **Next**.

   j. Server Encryption — This window enables you to specify the encryption that is used by the server. Accept the default settings. Click **Next**.

   k. Estimated System Size — Specify a size estimate for your SAS Enterprise Miner installation.

   l. Specify Email Server — Use this window to configure the SMTP server that is used to send an email alert. Specify the **Host Name** and **Port**. Click **Next**.
m. Email Addresses — Specify a sender and recipient for email alerts. Click Next.

6. SAS Server Configuration: Services
   a. SAS Object Spawner — Specify 8581 for the Operator Port. Click Next.
   b. SAS Object Spawner: Port Bank — Accept the default values. Click Next.
   d. SAS Workspace Server — Specify 8591 for the Port. Click Next.
   e. SAS Stored Process Server — Accept the default value for the Bridge Port. Click Next.
   f. Store Process Server: Multibridge Connections — Accept the default values. Click Next.
   g. SAS Web Infrastructure Platform Database Server — Enter the password for the database administrator. Click Next.
   h. SAS DATA Step Batch Server — Accept the default values. Click Next.
   i. Operating System Services Scheduling Server — Accept the default value of 8451. Click Next.
   j. Scheduling Services Cache Locator — Accept the default value of 41415. Click Next.
   k. Scheduling Services DIP Job Runner — Accept the default values. Click Next.
   l. IP Multicast Version — Specify the appropriate IP Version for your installation.
   m. IP Multicast — The multicast group communication includes all information that is needed to bootstrap SAS mid-tier applications. Because this includes sending the SAS environment credentials (such as the sasadm account name and its password), scoping and encryption options are provided. The default values are most appropriate for deployments in a firewall-isolated data center environment. The Deployment Wizard help documentation contains more information about these choices. Click Next.
   n. SAS Environment Manager Agent — Specify your fully qualified domain name in the SAS Environment Manager Host Name field. Accept the default settings for HTTP Port and HTTPS Secure Port. Enter the SAS Environment Manager Agent password. Click Next.
   o. SAS Internal Account: SAS Environment Manager Service Account — Specify the SAS Environment Manager Service Account Password for the SAS Environment Manager Service Account user name.
   p. Deployment Summary — Review the software that you have selected before you start the installation process. If this information is correct, Click Start.

7. Deployment Complete — The SAS Deployment Wizard checks all stages for errors or warnings. Click Next.

8. Additional Resources — It is suggested that you record these links for future reference. Click Finish.

9. Configuration Guidelines and Details
   - The information found on this page is specific to your installation and is kept in your configuration directory. In this example, that would be C:\SAS\EMTM \Lev1\Documents\Instructions.html.
10. Reboot — This is so that the user account’s Local Security Policy changes will take effect. This step is optional.

**Three Machine Setup, Stage 2 — Mid-Tier**

1. Log on to the computer that will be used as the SAS Enterprise Miner mid-tier machine. Start the SAS Deployment Wizard from the highest level directory in your SAS Software Depot with the setup application that is appropriate for your operating system. For example, on a Windows system, that file is setup.exe, and is located in the SAS Software Depot folder. Note that depending on any optional configuration of your software order, this might appear as Step 3.

2. Select your preferred language for the SAS Deployment Wizard. Click **OK**.

3. After the SAS Deployment Wizard opens, enter the following information in each screen.

   a. Select Deployment Task — Select **Install SAS software**. Click **Next**.

   b. Specify SAS Home — This is where you choose a file system location for the home folder for your SAS software. On a Windows system, this will default to `C:\Program Files\SASHome`. You can use the **Browse** button to navigate to an alternate location for your SAS Home. Click **Next**.

   c. Select Deployment Type — Select **Perform a Planned Deployment, Install SAS Software, Configure SAS Software**. Click **Next**.

   d. Specify Deployment Plan — For this example, select **EMiner, TMiner, three machines**. If your SAS representative provided you with a custom plan file, select **Specify the full path to a customized deployment plan**. You must specify the plan.xml file. Typically, the deployment plan is stored in the `plan_files` folder of the SAS Software Depot. If necessary, click **Browse** to navigate to your plan.xml file. Click **Next**.

   e. Select Deployment Step and Products to Install — The deployment plan determines the products to install and what order they are installed in. In the **Deployment Step** field, select **Step 3: Middle Tier**. Click **Next**.
f. Specify SAS Installation Data File — This is the path for your SID file. By default, the SID file is located in the SAS Software Depot under the `sid_files` folder. If necessary, click **Browse** to navigate to it. Click **Next**.

g. Select Region Settings — Specify how you want your SAS Software to format language, region, and locale-specific information. Also, you can configure SAS as a Unicode server, and force SAS to use the UTF-8 encoding in all data sets, catalogs, and text output. This can be useful if you need to share such files with computers that use different language representations. Click **Next**.

h. Specify Remote Communication Configuration — This window enables you to specify the port number and security configuration parameters for the SAS Deployment Agent. Accept the default values. Click **Next**.

i. Checking System — The SAS Deployment Wizard checks to ensure that the system has enough disk space and that the files and folders that it will write are accessible. Click **Next**.

4. The following information is needed to configure the software:

a. Review Required Software — This specifies the third-party software that will be required to continue the installation. SAS Enterprise Miner 14.2 requires Windows PowerShell 2.0. Click **Next**.

   *Note:* PowerShell is required only for Windows environments.

b. Specify Software Location — If Windows PowerShell 2.0 is already installed, this window will display the path to the installation directory. Click **Next**.

c. Select Configuration Prompting Level — Select **Typical** to display the basic set of configuration settings. To accept most defaults and for fewer options, select **Express**. For more granular configuration options, select **Custom**. To configure the SAS Enterprise Miner server, the **Typical** setting is recommended. Click **Next**.

d. Specify Configuration Information — This step creates your software configuration directory. The SAS Deployment Wizard can allocate up to ten configuration levels. The default settings create a level-1 configuration. For this example, the default configuration directory will be `C:\SAS\EMTM`, and the configuration level will be **Lev1**. This configuration is saved in `C:\SAS\EMTM`.
If you create a level–2 configuration, the default location in Windows systems is C:\SAS\EMTM\Lev2. Click Next.

e. Local Machine Name — By default, the Fully Qualified Local Host Name and the Short Local Host Name are given. Click Next.

f. Migration Information — Do one of the following:
   - If you are not upgrading from the previous release, then do not select Perform Migration. Click Next.
   - If you are upgrading from the previous, then do not continue with the remaining installation and configuration until you review the information in Chapter 4.

g. Integrated Windows Authentication — Detailed information about single sign-on is available in the SAS 9.4 Intelligence Platform Security Administration Guide. This example does not use Integrated Windows Authentication. By default, the box for Use Integrated Windows Authentication is not checked. Click Next.

5. Server Connection and Accounts

a. SAS Metadata Server — Enter the Host Name and Port used for the SAS Metadata Server in Stage 1 of these instructions. Click Next.

b. Deployment Accounts: Type of Accounts — SAS internal accounts are service entities that are used exclusively for SAS metadata administration. SAS internal accounts are intended to minimize the use of external accounts for SAS internal purposes. For this example, select Use SAS internal accounts when appropriate. Click Next.

c. SAS Internal Account: Unrestricted Administrator — This is the administrator for the SAS Metadata server. You must use the same password that was specified in the first step of these instructions. Click Next.

d. SAS Internal Account: Trusted User — This is a privileged metadata service account that is required to access metadata on behalf of users. You must use the same password that was specified in the first step of these instructions. Click Next.


f. SAS Internal Account: Anonymous Web User — If you enable anonymous web access, this window enables you to specify the password for the internal SAS account that is stored in the metadata server. Click Next.

g. Email Server — Enter the host name and port number for the SMTP mail server that will send messages to the system administrator when the metadata server encounters a problem. The host name and port number should automatically be retrieved from the server that you configured in Stage 1. Click Next.

h. Email Address — The Sender Email Address is the address that is used to send email messages to the system administrator. The Recipient Email Address is the address that will receive the server warnings. If your email server requires logon credentials, enable the option Email Server Requires Authentication. The email server user ID and password are entered on a subsequent page if you select this option. However, this example does not enable this option. Click Next.

6. Mid-Tier Configuration

b. SAS Web Server: Configuration — This window lists all current default web server configurations. Click Next.

c. Web Application Server: JMS Configuration — Accept the default values. Click Next.

d. Web Application Server: Cache Locator Configuration — Accept the default values. Click Next.

e. Web Application Server: Server Configuration — This is the logical name that will be used for your managed server. For this example, accept the default, SASServer1. Click Next.

f. Web Application Server: Server Ports — If you choose not to accept the default values, refer to your completed Pre-Installation Checklist for the values that you should enter. For this example, accept the default values. Click Next.

g. Web Application Server: Automatic Deployment — If you choose not to automatically deploy web applications, manual deployment instructions will be written to Instructions.html during the web application deployment stage. For this example, choose to have web applications automatically deployed to the web application server. Accept the default values. Click Next.

h. SAS Web Application Themes — Enter the fully qualified domain name to use when accessing themes. The default value is the name of the host where the configuration is performed. The port number provided here must be the same as the HTTP port of your managed server. If you choose not to accept the default values, refer to your completed Pre-Installation Checklist for the values that you should enter. The Configured Protocol is the communication protocol that is used when you access the installed themes. Accept the default value, which is HTTP Protocol. Click Next.

i. IP Multicast Version — Specify the appropriate IP Version for your installation.

j. SAS Content Server: Repository Directory — The SAS Content Server stores application objects, such as registered SAS Enterprise Miner Model Packages. Enter the location on your disk for the files of this repository. The SAS Content Server will work with a DBMS for persistence. For information about working with a DBMS, see “Administering the SAS Content Server” in SAS Intelligence Platform: Middle-Tier Administration Guide. Accept the default values. Click Next.

k. SAS Web Infrastructure Platform Database: JDBC Properties — Specify the user ID and password that are used to access the database that contains your SAS Web Infrastructure Database tables. If you have chosen automatic configuration of a database for the SAS Web Infrastructure Database, this user ID must have the ability to create tables and insert records. If you have not chosen automatic configuration, this user ID must have the ability to create tables, insert records, and delete records. Accept the default values. Click Next.

l. SAS Web Infrastructure Platform Database: JDBC Properties — This window enables you to specify the password for the shared services. Click Next.

m. SAS Environment Manager: Administration Database Configuration — This window enables you to specify the SAS Environment Manager Administration password. Click Next.

n. SAS Internal Account: SAS Environment Manager Service Account — This window enables you to specify the SAS Environment Manager Service Account password. Click Next.
o. SAS Environment Manager: Configuration — Accept the default values for HTTP Port and HTTPS Secure Port. Click Next.

p. SAS Environment Manager: Database Configuration — Enter the Database User, Database User Password, and Database Encryption Passphrase. Click Next.

q. SAS Environment Manager Agent Configuration — Accept the default values. Click Next.

r. SAS Environment Manager Enablement Kit Database Credentials — Specify the user name and password the SAS Environment manager Enablement Kit Database.

s. SAS Flex Application Themes — Specify the current fully qualified domain name. Click Next.

t. SAS Deployment Backup and Recovery Tool: Enable Central Vault — Accept the default selection. Click Next.

7. Deployment Summary — Review the software selections before starting the installation process. If everything is correct, click Start.

8. Deployment Complete — Check all stages for errors or warnings. Click Next.

9. Additional Resources — Record these links for future reference. These links will be needed in the post-installation process. Click Finish.

10. Configuration Guidelines and Details — This page of information is specific to your installation and is kept in your configuration directory. In this example, that would be C:\SAS\EMTM\Lev1\Documents\Instructions.html.

Three Machine Setup, Stage 3 — Client
1. For the client installation, log on to the computer that will be used as the SAS Enterprise Miner client machine. Start the SAS Deployment Wizard from the highest-level directory in your SAS Software Depot using the setup application that is appropriate for your operating system. For example, on a Windows system, this is the file setup.exe, located in the SAS Software Depot folder. Note that depending on your software order, this might appear as Step 5.

2. Select your preferred language for the SAS Deployment Wizard. Click OK.

3. After the SAS Deployment Wizard opens, enter the following information:
   a. Select Deployment Task — Select Install SAS Software. Click Next.
   b. Specify SAS Home — Choose a file system location for the home folder for your SAS software. On Windows systems, this will default to C:\Program Files\SASHome. You can use the Browse button to navigate to an alternate location for your SAS Home. Click Next.
   c. Select Deployment Type — Accept the default settings. Click Next.
   d. Select Deployment Plan — Select EMiner, TMiner, three machines. If your SAS representative provided you with a custom plan file, select Specify the full path to a customized deployment plan. This is the plan.xml file. Typically, the deployment plan is stored in the plan_files folder of the SAS Software Depot. If necessary, click Browse to navigate to your plan.xml file. Click Next.
   e. Select Deployment Step and Products to Install — The deployment plan determines which products to install and in what order. In the Deployment Step field, select Step 5: Clients. Click Next.
f. Select SAS Enterprise Miner Guide Mode — Select your operating system architecture. Click Next.

g. Select SAS Add-in for Microsoft Office Mode — Select your operating system architecture. Click Next.

h. Specify SAS Installation Data File — This is the path to your SID file. By default, the SID file is located in the SAS Software Depot under the sid_files folder. If necessary, click Browse to navigate to this file. Click Next.

i. Select Language Support — Select the languages that you want to install for the products that are listed. Only those languages that work with your locale are installed. Click Next.

j. Select Regional Settings — Specify how you want your SAS Software to format and display language, region, and locale-specific information. Also, you can configure SAS as a Unicode server and force SAS to use UTF-8 encoding in all data sets, catalogs, and text output. This can be useful if you need to share these files with computers that use different language representations. Click Next.

k. Select Microsoft Office Applications — Specify the Microsoft Office applications for which the SAS Add-In for Microsoft Office is installed.

l. SAS Environments URL — Enter the URL for the SAS Environment File that you chose in the Pre-Installation Tasks for SAS Enterprise Miner. This step lets you avoid manually creating and deploying a sas-environment.xml before using SAS Enterprise Miner. The default URL will resemble http://myserver.mynet.mycompany.com:80/sas/sas-environment.xml. For this example, the network machine name myserver.mynet.mycompany.com would be replaced with the name of the machine that contains the SAS middle tier, installed in Step 2 of these instructions. Click Next.

m. Checking System — The SAS Deployment Wizard checks to ensure that the system has enough disk space and that all files and folders that it needs to write are accessible. The installation cannot proceed until access is granted to any listed files. When the examination of your file system is complete and there are no files, click Next.

n. Select Configuration Prompting Level — Select Typical to display the basic set of configuration settings. To accept most defaults, and for fewer options, select Express. For more granular configuration options, select Custom. To configure the SAS Enterprise Miner server, the Typical setting is recommended. Click Next.

o. Specify Configuration Information — This step creates your software’s configuration directory. The SAS Deployment Wizard allocates up to ten configuration levels. The default settings create a level–1 configuration. For this example, the default configuration directory is \SAS\EMTM, and the configuration level is Lev1. This configuration is saved in \SAS\EMTM\Lev1. If you create a level–2 configuration, it will be saved in \SAS\EMTM\Lev2. Click Next.

p. Local Machine Name — By default, the Fully Qualified Local Host Name and the Short Local Host Name are provided. Click Next.

q. Migration Information — Do one of the following:

• If you are not upgrading from the previous release, then do not select Perform Migration. Click Next.
• If you are upgrading from the previous release, do not continue with the remaining installation and configuration until you have reviewed the information indicated in Chapter 4.

r. Integrated Windows Authentication — (If prompted) Detailed information about single sign-on is available in the SAS 9.4 Intelligence Platform Security Administration Guide. In this example, do not select the check box for Use Integrated Windows Authentication. Click Next.
s. SAS Metadata Server — Enter the host name and port that is used for the SAS Metadata Server, as specified in Step 1 of these instructions. Click Next.
t. Deployment Summary — Review the software selections before starting the installation process. If everything is correct, Click Start.
u. Deployment Complete — Check all stages of the installation for errors or warnings. Click Next.
v. Additional Resources — Record these links for future reference. Click Finish.

4. Configuration Guidelines and Details

• This page of information is specific to your installation and is kept in your configuration directory. In this example, that directory is C:\SAS\EMTM\Lev1\Documents\Instructions.html.

---

**Deployment Errors and Warnings**

**Error Status**

When an error status is returned to the SAS Deployment Wizard, it displays the message that describes the problem encountered, and asks what further action to perform. The SAS Deployment Wizard offers a choice of actions. They include stopping, continuing, or retrying.

If you select No, the SAS Deployment Wizard ends the deployment at that point. If you choose Yes to continue, the SAS Deployment Wizard will start the next configuration step in the list. If the error message indicates a correctable problem, you might be able to handle the problem outside the SAS Deployment Wizard. In such a case, you can then choose to Retry, and the SAS Deployment Wizard will try to start the step over.

**Warning Status**

In situations where a step was only partially successful, but can be resolved outside the SAS Deployment Wizard post-installation, the SAS Deployment Wizard sets the warning status flag and continues as if it were successful.

The SAS Deployment Wizard does not ask whether you want to cancel, continue, or retry. However, information about the warning is written to a special section in Instructions.html. The Instructions.html is located in your config-dir in the Documents folder.
Verify the Installation

Overview

After the installation and configuration is complete, you will want to verify your deployment. To verify that SAS Enterprise Miner is operational, start the SAS Enterprise Miner client, create a project, create a diagram, and run a node.

Starting SAS Enterprise Miner

For an installed client on the Windows operating system, the Start menu will contain a SAS folder that includes a shortcut to SAS Enterprise Miner Client 14.2 or SAS Enterprise Miner Workstation 14.2.

To start the SAS Enterprise Miner 14.2 client using Java Web Start, open the SAS Enterprise Miner Status page. That page will be similar to the following: http://myserver.mynet.mycompany.com:80/SASEnterpriseMinerJWS/Status. If you are using Java Web Start, then you need to install a third-party JRE.

Note: You will replace myserver.mynet.mycompany with the URL to the server that SAS Enterprise Miner was installed on.

Select the Launch link to start Java Web Start to load and run the SAS Enterprise Miner 14.2 client.

Run SAS Enterprise Miner Client 14.2

Log on to SAS Enterprise Miner using the Product Administrator, first user, or any other SAS Enterprise Miner account that you have created. In most cases, the Enterprise Miner Log On window will resemble the image shown below.
In the SAS Enterprise Miner window, select **New Project**.
In the Create New Project window, accept the default SAS Server and click Next.

In the Project Name text box, enter Test1. In the SAS Server Directory text box, enter the path to a folder that is accessible by your account from the server machine. This folder will contain your project folders and files. For testing and verification, you can use C:\Temp. You can use the Browse button to navigate to your file system and choose a more appropriate folder. For example, you can use C:\EMProjects\userid. Click Next.
The **SAS Folder Location** is where the project metadata is saved. For verification purposes, accept the default location and click **Next**.

The final step of the New Project Wizard displays the **New Project Information**, which reviews the information given in the previous windows. Click **Finish**. For a more in-depth tutorial on how to create a new project, see the SAS Enterprise Miner help documentation.
In the Enterprise Miner — Test 1 window, select Help ⇒ Generate Sample Data Sources.

In the Generate Sample Data Sources window, click OK.
In the Project Panel, you should see the data sources that were created.

In the Project Panel, right-click **Diagrams** ➔ **Create Diagram**. In the Create New Diagram window, enter **TestA** and click **OK**. A new project diagram opens.
After creating a new diagram, the project workspace for that diagram will open automatically. In the Project Panel, select the **Home Equity** data source. Click and drag this data source into the Diagram Workspace, as shown in the image below.

Right-click the **Home Equity** node and select **Run**.
In the Confirmation window, select **Yes**.

You should quickly see a Run Status window that indicates a successful run of the data source.

Click **OK** to close the Run Status window.

At this point, the verification is complete, and you have successfully installed and run all the major components of SAS Enterprise Miner. To close SAS Enterprise Miner, you can close the Enterprise Miner window, or select **File ⇒ Exit**. At the Confirmation window, select **Yes**.
Chapter 6
SAS Enterprise Miner Workstation
Installation and Configuration

SAS Enterprise Miner Workstation Deployment

For environments where a server-based installation is not required, the SAS Enterprise
Miner Workstation installation supports a single-user, single-machine installation. The
single-user Workstation installation is not a planned installation and is a simpler process
than the Server installation. It can be installed on any 64-bit Microsoft Windows
operating system that is supported by SAS.

Note: The SAS Enterprise Miner Workstation, SAS Enterprise Miner Desktop, and SAS
Enterprise Miner Classroom releases are virtually identical installations.

1. For the SAS Enterprise Miner Workstation installation, no SAS Web Application
Server is required after your system is prepared and the pre-installation tasks are
complete. You need to log on to the target machine with Administrator privileges.
Start the SAS Deployment Wizard from the highest-level directory in your SAS
Software Depot using the setup application that is appropriate for your operating
system. For example, on a Windows system, that file is setup.exe and is located in
the SAS Software Depot folder.

2. Select your preferred language for the SAS Deployment Wizard.

3. Enter the following information:
   a. Select Deployment Task — Select Install SAS Software. Click Next.
   b. Specify SAS Home — Choose a file system location for the home folder for your
      SAS software. On Windows systems, this will default to C:\Program Files\SASHome. You can use the Browse button to navigate to an alternate location
      for your SAS Home. Click Next.
   c. Select Deployment Type — Select Install SAS Foundation and Related
      Software. Click Next.
   d. Select Products to Install — All of the products in your order are listed on this
      page. The default values that are selected are those that are typically installed
      with SAS Enterprise Miner Workstation. Click Next.
   e. Select SAS Enterprise Guide Mode — Specify whether SAS Enterprise Guide
      will run in 64-bit Native Mode or 32-bit Compatibility Mode. Click Next.
f. Select SAS Foundation Products — The defaults that are selected are all of the SAS Foundation products in your order. Generally, you will want all of the products in your order. Click Next.

g. Specify SAS Installation Data File — This is the path to your SID file. By default, the SID file is located in the sid_files folder of your SAS Software Depot. If necessary, click Browse to navigate to this file. Click Browse.

h. Select Language Support — Select the languages that you want to install for the products that are listed. Only those languages that work with your locale are installed. Click Next.

i. Select Regional Settings — Specify how you want your SAS Software to format and display language, region, and locale-specific information. Also, you can choose to configure SAS as a Unicode server and force SAS to use UTF-8 encoding in all data sets, catalogs, and text output. This can be useful if you need to share these files with computers that use different language representations. Click Next.

j. Default Product for SAS File Types — Accept the default setting. Click Next.

k. Specify SAS Clinical Standards Toolkit Libraries — Accept the default settings. Click Next.

l. Specify Environments URL — Specify a SAS Environments URL in the form of http://localhost.localdomain:80/sas/sas-environment.xml where localhost.localdomain is the current machine.

m. Specify SAS Text Analytics Document Conversion Host and Port — When you install SAS Text Miner with SAS Enterprise Miner, then SAS Document Conversion is installed on the same machine. The host name defaults to the machine name, and the default port value is 7111. Click Next.

n. Checking System — The SAS Deployment Wizard checks to ensure that the system has enough disk space and the files and folders that it will write are accessible. The installation cannot proceed until access is granted for any listed files. When the examination is complete, click Next.

o. Deployment Summary — Review the software that is selected before starting the installation. If everything is correct, Click Next.

p. Deployment Complete — Check all stages for errors or warnings. Click Next.

q. Additional Resources — Record these links for future reference. Click Finish.
Chapter 7
Post-Installation Information

About Post-Installation Tasks

Because installation environments and preferences vary, there are tasks that you will want to perform after you have deployed SAS Enterprise Miner successfully. This chapter offers some guidelines and recommendations to customize the installed software for your needs. After the installation and configuration is complete, you need to verify your deployment, adjust the various customizations available, and configure any other SAS Enterprise Miner accounts that you might need.

Configuration Guidelines and Details

Review the manual configuration instructions for each installation. Information specific to each installation is kept in the configuration directory on each machine in a file named Instructions.html. This file is saved to the configuration folder during deployment (for example, C:\SAS\EMTM\Lev1\Documents\Instructions.html).

On Windows systems, there are required tasks for installations that include SAS Text Miner. If you are installing on multiple machines, the post-installation steps for the SAS Text Miner Client are in the Instructions.html file for the mid-tier component.
Check for Current Hot Fixes


Hot fix announcements and other important news from SAS Technical Support are posted to the listserv TSNEWS-L. For more information, and to subscribe, visit http://support.sas.com/techsup/news/tsnews.html.

Configure SAS Enterprise Miner in SAS Management Console

Overview

SAS Management Console has a plug-in for SAS Enterprise Miner. This plug-in enables you to browse and customize some of the features of SAS Enterprise Miner. And it provides access to attributes of the logical workspace server and a server-specific list of projects. The SAS Enterprise Miner plug-in provides access to the list of mining result packages that have been registered via SAS Enterprise Miner. For more information about SAS Management Console, see SAS 9.4 Management Console Guide to Users and Permissions.

Starting SAS Management Console

In Windows, you can start SAS Management Console from the SAS shortcuts located in your Start menu. In UNIX systems, navigate to SASHOME, which is similar to /SASHome/SASManagementConsole/9.4, and run the command ./sasmc &. After SAS Management Console has started, connect as a SAS administrator (for example, sasadm@saspw).

SAS Enterprise Miner Plug-in

Under the Plugins tab of SAS Management Console, expand the Application Management folder. Next, expand the Enterprise Miner Plug-in. Expand the Projects folder to display a list of all of the SAS Enterprise Miner servers. When you select the icon for SASApp — Logical Workspace Server, a list of all the projects created by that server is displayed in the adjacent pane on the right. Expand the Models folder to access the list of model results packages that are registered from SAS Enterprise Miner to this server.

You can view and customize Logical Workspace Servers, even if you do not have any registered SAS Enterprise Miner projects. Servers recognize custom project settings when new projects are created on the servers.
Logical Workspace Server Customizations

The behavior of each Logical Workspace Server definition can be customized for SAS Enterprise Miner in the following ways:

• By specifying default locations for new projects on a server.

• By specifying whether users can modify the default location for new projects on a server.

• By specifying the maximum number of concurrent tasks that are allowed on a particular server. The maximum concurrent tasks setting affects the extent of parallel processing that SAS Enterprise Miner can use in a data mining process flow. You can use this setting to tune your symmetric multiprocessor server environment for optimal performance.

• By specifying SAS initialization code that is run when a project is opened, or when process flow diagram results or model result packages are generated. SAS initialization code is similar to the Project Start-up Code feature of SAS Enterprise Miner projects, except that SAS initialization code can initialize all SAS sessions for all projects that are associated with a particular server.

• By providing an alternate command to launch any SAS/CONNECT sessions that are called by nodes in a data mining process flow.

After you navigate to the SAS Enterprise Miner plug-in, you can customize the properties for a SAS Enterprise Miner server with the following steps:

1. Expand the Projects folder to display a list of all of the SAS Enterprise Miner Servers. Select the icon for SASApp — Logical Workspace Server.

2. Right-click the icon for a server under the Projects folder, and then select Properties from the pop-up menu.
3. When the Logical Workspace Server Properties window appears, select the **Options** tab.
You can perform the following tasks in the **Options** tab:

- **Set Default Project Location** — You can customize the Default Location for New Projects by entering a path. All new SAS Enterprise Miner projects that are created on this server default to the path that you specify. If you want to prevent users who create projects from changing the default project location, click **Do not allow users to change this location**.

- **Set Maximum Concurrent Nodes** — In **Max. Concurrent Nodes**, specify the maximum number of concurrently running nodes that you want to allow in project process flow diagrams.

- **Set Initialization Code** — In the **Initialization Code** box, enter the path (on this server) to a project start-up file, if you want to use one. A project start-up file is a text file that contains SAS code that is run when a project is opened, a process flow diagram is run, or when result reports are generated.

- **Set MPCONNECT Launch Command** — In the **MPCONNECT launch command** box, you can enter an alternate command to use when you launch MPCONNECT sessions. Normally, it is safe to leave the MPCONNECT launch command box blank. There might be cases when you would like to modify some SAS system defaults for sessions that are used when running process flow diagrams. The following default command is used when this box is left blank: `!sascmdv -noobjectserver -nosyntaxcheck -noasynchio`. 

![SASApp - Logical Workspace Server Properties](image-url)
This command has the same effect as using the SAS command that was used to launch the SAS workspace session when project is opened.

- Set WebDAV URL — (optional) In the WebDAV URL field, you can enter the URL to your WebDAV server. If you specify a WebDAV server, the SAS Enterprise Miner model result packages that you save are copied to the WebDAV server location when the model packages are registered.

4. Click OK to save your changes.

---

**Define Additional SAS Enterprise Miner Users**

Logging on to a client/server installation of SAS Enterprise Miner requires an operating system user ID and a SAS Enterprise Miner account. This section provides instructions on how a SAS Administrator can create a new SAS Enterprise Miner account in SAS Management Console.

Each user of the SAS Enterprise Miner Server needs a domain account that has enabled the user with rights to Log on as batch job. See your operating system help for specific information about configuring this security setting. For systems with multiple users, a system group with all appropriate rights and permissions is recommended. On Windows systems, that would include the Log on as batch job security setting.

To simplify adding multiple accounts in SAS Management Console, it is possible to create a custom group. For more information about SAS Management Console and creating custom groups, see the *SAS 9.4 Management Console Guide to Users and Permissions*.

Each SAS Enterprise Miner system account must be registered in SAS Management Console. SAS Management Console provides a single interface for easier management of many SAS administrative tasks. To create a new SAS Enterprise Miner identity in SAS Management Console, use domain (or machine name) credentials and a user account that already exists on the machine. The user ID must exist on the operating system before the user ID can be registered via SAS Management Console.

Follow the instructions below to create an identity within SAS Management Console. After you create the new identity, users can log on to SAS Enterprise Miner using these credentials.

1. On the server, log on to SAS Management Console as Administrator (sasadm@saspw).
3. Right-click the User Manager plug-in and select New ⇒ User.
4. On the **General** tab of the New User Properties window, enter a value for **Name**. All of the other fields are optional.

5. Select the **Groups and Roles** tab. In the **Available Groups and Roles** pane, select **SAS System Services**. Move them to the **Member of** pane with the arrow button that is between the two panes. You can apply any other group membership or roles by repeating this process.
6. Select the **Accounts** tab. On the right, select the **New** button. In the New Login Properties window, enter the new user’s domain account. If the user ID is for a Windows account, it must be stored in a qualified format (such as windows-domain\user or machine-name\user). A password is optional, but can be useful for a login that provides access to a third-party database server that uses proprietary authentication. **Authentication Domain** can be used to assign the login to a category within the SAS metadata. The Authentication Domain for SAS Enterprise Miner login accounts must be **DefaultAuth**.

**Note:** On a Windows system, this account also requires the account permissions **Log on as a batch job** and **Access this computer from the network**. These permissions enable the user to be logged on by means of a batch-queue and access to the SAS Metadata server. You can configure these security settings by opening the appropriate policy and adding each account. Generally, it is recommended that you create a user group, and give the group **Log on as a batch job** permission, and if required **Access this computer from the network**, permission. Then, add each account to that group. For more information about required security policies see [http://support.sas.com/documentation/cdl/en/bisecag/65011/HTML/default/titlepage.htm](http://support.sas.com/documentation/cdl/en/bisecag/65011/HTML/default/titlepage.htm).
7. Click **OK** in the New Login Properties window.
8. Click **OK** in the New User Properties window.
9. In Windows systems, if the operating system account is not already added to the **Log on as a batch job** setting, you need to do one of two things. Either add that user to a group that has the **Log on as a batch job** privilege, or assign that privilege to the individual user.

The new account should now be able to log on to SAS Enterprise Miner.

---

**Create a SAS Environment File**

A SAS environment file defines the available set of SAS environments for SAS client applications, and is generated during the configuration of the SAS Web Infrastructure Platform. The SAS Logon Manager includes a servlet that provides default information for the initial deployment. After you determined that your client applications work successfully with a deployment, it is recommended that you deploy the sas-environment.xml file to an HTTP server. This step ensures that you can customize the sas-environment.xml file to specify the name that you want to use and to account for the IT topology at your site.

Note that if a SAS Web Server is configured, then no action is required.

For details about how to customize and deploy your SAS Environment file, see the section on Configuring the SAS Environment File in the *SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide*. 

Chapter 8
Administrative Tasks and Information

SAS Enterprise Miner Overview for Administrators

SAS Enterprise Miner uses process flows to analyze enterprise data, create predictive and descriptive models, and interpret the models. The process flows are generated in a graphical user interface that enables interaction between statistical analysts, IT professionals, and business analysts. Full details about the administration of the SAS servers used by SAS Enterprise Miner are available in the SAS 9.4 Intelligence Platform: System Administration Guide.
Publishing Extension Tools

Overview

Extension nodes provide a mechanism for extending the functionality of SAS Enterprise Miner. Extension nodes can be developed to perform almost any essential data mining activity. In SAS Enterprise Miner, the essential data mining activities are divided into the following five groups: Sample, Explore, Modify, Model, and Assess (known as SEMMA). Although SAS Enterprise Miner is designed to satisfy the needs of a diverse audience, extension nodes provide you a means to develop custom solutions.

Each extension node consists of four files.

- `<extension_name>.sas7bcat` — SAS code for the extension node.
- `<extension_name>.xml` — Definition of the extension node for the graphical user interface.
- `<extension_name>_16.gif` — A small, 16–bit GIF file that serves as the extension node’s icon on the node toolbar.
- `<extension_name>_32.gif` — A large, 32–bit GIF file that serves as the extension node’s image in the diagram workspace.

The extension node files must be available to the SAS Server. It is recommended you create a folder accessible by everyone that will use the extension tool (for example EMEXT). You must add the XML file to the extension node folder and create two subdirectories in this folder named `gif16` and `gif32` to hold the 16- and 32-bit icons, respectively.

The SAS code for the extension node must be available to the SAS server. It is recommended that you put your code in catalog source entries. The path to the SAS code is stored in the extensions.xml file. If you add the path for your EMEXT folder to the SASHELP concatenation in the SAS system configuration file, then the catalogs in the EMEXT folder will be found by the server. Because the path to the SAS code is stored in the extensions.xml file, when creating your own extension node, you need to edit your extensions.xml file to specify your catalog and source entry.

An example extension node (EXT Demo) is part of SAS Enterprise Miner. See the SAS Enterprise Miner in-product help for details about the EXT Demo.

For client/server configurations, the four files in the EXT Demo node are as follows:

- SASHELP.EMUTIL.EXTDEMO.SOURCE
- C:\Program Files\SASHome\SASEnterpriseMinerMidTier\14.2\Static\wars\sas.enterpriseminer.svcs\WEB-INF\classes\components\ExtDemo.xml
- C:\Program Files\SASHome\SASEnterpriseMinerMidTier\14.2\Static\wars\sas.enterpriseminer.svcs\WEB-INF\classes\components\gif16\ExtDemo.gif
- C:\Program Files\SASHome\SASEnterpriseMinerMidTier\14.2\Static\wars\sas.enterpriseminer.svcs\WEB-INF\classes\components\gif32\ExtDemo.gif

For workstation configurations, the four files in the EXT Demo node are as follows:
• SASHELP.EMUTIL.EXTDEMO.SOURCE
• C:\Program Files\SASHome\SASEnterpriseMinerWorkstationConfiguration\14.2\WEB-INF\classes\components\ExtDemo.xml
• C:\Program Files\SASHome\SASEnterpriseMinerWorkstationConfiguration\14.2\WEB-INF\classes\components\gif16\ExtDemo.gif
• C:\Program Files\SASHome\SASEnterpriseMinerWorkstationConfiguration\14.2\WEB-INF\classes\components\gif32\ExtDemo.gif

**Workstation Extension**

For Workstation configurations, if the EMEXT folder is created under User Home on Windows 7 (for example `C:\User\<userid>\EMEXT`), it will be found automatically. For any other location, define a system environment variable named `dminemid.components.extra.dir` that contains the path for the directory that contains the extension XML file. It can be any directory accessible from the machine.

**Server Extensions**

For a server configuration, specify the location of the extensions folder by adding a definition in the SAS Management Console. To add a definition, follow the steps below.

1. Log on to the SAS Management Console as a SAS administrator.
2. On the **Plug-ins** tab, select **Application Management ➔ Configuration Manager ➔ SAS Application Infrastructure**. Right-click **Enterprise Miner Mid-tier Services 14.2 ➔ Properties**.
3. On the **Advanced** tab, locate the property named `dminemid.components.extra.dir`. In the **Property Value** field, enter the directory path to your extensions folder.
4. You must restart the SAS Enterprise Miner client and the middle-tier server in order to see the new node.

For more information about the extension tools and the EXT Demo node, see the SAS Enterprise Miner Help documentation.

---

**Troubleshooting**

**Overview**

When you are troubleshooting unexpected application behavior, it is important to isolate and describe the problem and the context in which it occurs. The following are the general classes of information that can expedite resolution of a technical problem:

• operating system environmental and configuration information
• detailed problem description
• sample test data
• log files
• client message logs
• other files or screen shots

**Operating System Environmental and Configuration Information**

If you are going to request help from SAS Technical Support, providing the following information about your installation on each machine involved can expedite the processing of your report:

• your hardware platform
• your operating system name, version, word size, and service level
• the overall system load, including the amount of physical memory available and processor utilization
• the amount of disk space available and the location of the SAS Work folder and the SAS Enterprise Miner project root folder
• the number of processors
• the approximate number of SAS users
• the Java Runtime Environment version when using Java Web Start
• the SAS version and SAS service pack or patch level, including any hotfixes
• the SAS Enterprise Miner version number and patch level
• your server language and locale
• whether a firewall exists between the client and server that regulates configuration information, port availability, and communication direction

*Note:* You need to provide the preceding information only once, unless it has changed since previous reports.

**Problem Description**

In order to get the best help, provide a scenario description that includes as much information as possible on how to reproduce the problem. Include a description of the general task that you are trying to accomplish, your role and permissions, and the state of your session before the problem is observed. It is also helpful to provide the complete process flow diagram, model package, or EM Batch code that was used when the problem was encountered.

Provide details such as the following:

• Is this a client/server environment or a single machine?
• If client/server, are you connecting to the server via Java Web Start through the Internet browser?
• Are you working with new data or updating existing data?
• Have you tried different data?
• What browser and version are you using?
• Is the problem locale-specific? If so, which locales are having problems?
Sample Test Data

Since problems can often only be reproduced with specific data, a small sample of the data is often critical to diagnosing the problem.

Log Files

There are logs kept for the project, the diagram, and each node in the flow. Additional logging can be turned on by defining the macro variable EM_DEBUG. See the SAS Enterprise Miner Help for more information.

The following logs are available in SAS Enterprise Miner:

- For the project log, select View ⇒ Project Log.
- For the diagram log, select the Log tab at the bottom of the diagram.
- For a node’s log, right-click the node and select Results. In the Results window, select View ⇒ SAS Results ⇒ Log.

When SAS Enterprise Miner Server catches and logs problems, it attempts to log as much information as it can under the circumstances. The log often captures detailed exception information that you can send to SAS Technical Support.

Note: It is helpful to send the complete text of the Java stack trace that surfaced on the application error page. SAS Technical Support prefers that you do not send a screen shot of this information because often the screen shots do not include the full text of the trace.

SAS Enterprise Miner Client Message Logging

When reporting a problem to SAS Technical Support, you need to enable the Java Console in order to get the maximum information available from the SAS Enterprise Miner Client. The Java Console is enabled from the Java Control Panel.

To open the Java Control Panel in Windows, open the Windows Control Panel and select Java. In the Java Control Panel select the Advanced tab, expand the Java console item, select Show console, and click Apply.
You can get more information about the Java Console and its capabilities from the Java Console documentation available at http://download.oracle.com/javase/6/docs/technotes/guides/deployment/deployment-guide/console.html.

Adding a New Workspace Server for SAS Enterprise Miner

First, familiarize yourself with the following documentation:


Complete the following steps to add a new workspace server to your SAS Enterprise Miner installation:

1. Start the SAS Deployment Wizard from the highest-level directory in your SAS Software Depot using the command that is appropriate for your operating system. On Windows systems that file is setup.exe. For UNIX systems, use setup.sh.

2. Select Install SAS Software. Click Next.

3. Select Perform a Planned Deployment, deselect Install SAS Software, and check only Configure SAS Software. Click Next.

4. You must use the same deployment plan that was used when you installed the original server component. This example uses one of the standard deployment plants.
Choose **Select a standard deployment plan**, and from the drop-down menu select EMinerTMiner3. Click **Next**.

5. **Checking System** should already be complete. Click **Next**.

6. In Select User Account Mode, you will most likely want to choose **Multiple-User Mode**. Click **Next**.

7. In Select Configuration Prompting Level, select **Typical**. Click **Next**.

8. In Specify Configuration Information, you must choose the same options as your original installation. For this example, use the default settings. Click **Next**.

9. The SAS Deployment Wizard warns you that the configuration directory and level specified contain existing files. Select **Yes**.

10. In Select Products to Configure check **SAS Workspace Server**. Click **Next**.

11. In Local Machine Name, accept the defaults. Click **Next**.

12. In Migration Information, no migration should be performed. Click **Next**.

13. In Integrated Windows Authentication, accept the default settings. Click **Next**.

14. In SAS Metadata Server, accept the default settings. Click **Next**.

15. In Deployment Accounts: Type of Accounts, select **Use SAS internal accounts when appropriate**. Click **Next**.

16. In SAS Internal Account: Unrestricted Administrator, enter the same password that was used in the original installation. Click **Next**.

17. In Deployment Accounts: First User, there is no need to set up a first user ID. Click **Next**.

18. In Create SAS Application Server Context, select **Create a SAS Application Server Context**. Click **Next**.

19. In SAS Application Server: Server Context, enter **SASApp_2** in the field **SAS Application Server Context Name**. Click **Next**.

20. In SAS Server Dependencies, confirm that the value of **SAS Application Server Context** is **SASApp_2**. Click **Next**.

21. In SAS Workspace Server, enter the workspace server port. This example uses the default value, 8592. Click **Next**.

22. Check the deployment summary and click **Start**. Once the SAS Deployment Wizard is finished, note the additional resources and click **Finish**.
Next you need to configure the Job Execution Service and restart the SAS web application servers.

1. Run the SAS Management Console and open the **Plug-ins** tab. Select SAS Application Management ⇒ Configuration Manager ⇒ SAS Application Infrastructure ⇒ Web Infra Platform Services 9.4 ⇒ JobExecutionService.

2. Right-click **JobExecutionService** and select **Properties**.

3. Open the **Settings** tab in the JobExecutionService Properties window and locate the **Configure Execution Queues from Available Server Contexts** section.

4. Select the new server, which is **SASApp_2** in this example. Then move it to the **Selected** list. In the **SASApp_2 Execution Queue Properties** section, deselect **Enable for interactive execution?**.
Note: By default, **Enable for interactive execution?** is enabled, but not needed by SAS Enterprise Miner. You should disable this option. In addition, it is strongly recommended that the value specified for **Job Queue Maximum Threads** is 4 times the number of CPUs available for workspace servers.

5. Click **OK**.

6. If you have multiple SAS web application servers, stop **SASServer1_11**.

7. Restart the SAS Web Application Server **SASServer1_1**. For example, in a default Windows installation this can be done from the Windows Management console for Services by restarting the Service name, **SAS [EMTMVA-Lev1] WebAppServer SASServer1_1**.

8. If necessary, start **SASServer1_11**.

To verify your new server from SAS Enterprise Miner, log on to SAS Enterprise Miner and create a new project that uses the new logical workspace server. Then create a diagram, create a data source, place the data source on your diagram, and run the diagram. You can select the new logical workspace server in Step 1 of the New Project Wizard.

Important information about managing and configuring your workspace server can be found under Managing Workspace Servers and Stored Process Servers in the **SAS 9.4 Intelligence Platform Application Server Administration Guide**.
SAS Enterprise Miner Model Package Registration

Overview

One of the ways SAS Enterprise Miner data mining models can be deployed is as a Model Package. A model package is a snapshot of a process flow from the perspective of the reporting node. Model Package files enable you to save results and settings for an entire process flow. Instructions for creating a Model Package are in the SAS Enterprise Miner 14.2 Reference Help. To access the SAS Enterprise Miner 14.2 Reference Help start the SAS Enterprise Miner client and select Help ➜ Contents.

By default, model packages are stored within the SAS Enterprise Miner Reports subdirectory of your project directory. You can also set up a Model Repository and register your model packages there. The Model Repository enables you to store and access models conveniently from numerous projects and diagrams in a centralized location. Models are exported from SAS Enterprise Miner to the Model Repository through the SAS Metadata Server. Models and their associated metadata are stored in the repository and can be searched and used by analysts and applications throughout your organization.

The model repository is implemented by a combination of the SAS Metadata Server and the SAS Content Server. The SAS Content Server is included in each Client Server deployment of SAS Enterprise Miner. SAS Enterprise Miner stores registered model package files in the SAS Content Server using the WebDAV ("Web Distributed Authoring and Versioning") interface.

Set Up the SAS Content Server

To enable registration of SAS Enterprise Miner model packages, you must first access the SAS Content Server and create a public directory for SAS Enterprise Miner.

1. Access the SAS Content Server Administration Console by navigating to http://hostname:port/SASContentServer/dircontents.jsp in a web browser. The value of hostname:port depends on your network structure, but an example of hostname:port is localhost:80 for Windows and localhost:7980 for UNIX. Log on using the SAS Administrator account (for example, sasadm@saspw) that you defined during the SAS installation process.

2. In the Add folder field, enter a folder name, such as EM_Models.

3. Click Add folder.

4. The EM_Models folder is displayed in the Item name column.

5. Click the Permissions icon that is associated with the EM_Models folder.

6. In the Add principal field, enter the value jcr:all. Change all of the permissions to Yes.

7. Click Save Changes.

8. Log off from the SAS Content Server Administration Console.
**Configure the Workspace Server for Model Package Registration**

Each SAS Enterprise Miner Workspace Server that will be used to register model packages needs to be given the URL for the location in the SAS Content Server where the package files will be stored. In the SAS Management Console, on the **Plug-ins** tab, expand **Application Management**. Expand the **Enterprise Miner** plug-in to reveal the subfolders.

1. Expand the **Projects** folder.
2. Right-click the SAS Workspace Server that is associated with your SAS Enterprise Miner installation and select **Properties**. For example, you might see **SASApp — Logical Workspace Server**.
3. Open the **Options** tab.
4. In the **WebDAV URL** field, enter `http://hostname:port/SASContentServer/repository/default/EM_Models/`. Note that `hostname` must be a fully qualified machine name.
5. Click **OK**.

**Verify the Model Package Registration**

Detailed instructions for the creation and registration of a model package are available in the SAS Enterprise Miner Help. The following steps provide an outline of model package registration process, not an example of that process.

1. Launch SAS Enterprise Miner.
2. Open a project on the workspace server that was configured for registration.
3. Open a process flow diagram.
4. Run any process flow within that diagram.
5. Create a model package.
6. Register the model package that you just created.

To check the metadata for the registered model, select **Client View ⇒ Metadata** and then navigate to the folder that contains the model package. You might need to specify that value in the **Look in** field. Registered model packages have a type of **MiningResults**.

To ensure that the model package file was successfully deployed to in the SAS Content Server, open a web browser and navigate to the WebDAV URL that was specified for the Workspace Server in the SAS Enterprise Miner plug-in for SAS Management Console. The registered model package should present.

Note that a model package, which has a .SPK extension, is a compressed file. Whenever you send a compressed file to SAS Technical Support, please make sure the filename begins with the letters **ZQJ** (for example, qj_myfilename.zip) to avoid it being stripped by our email filters. The model package contains the settings, logs, and results from the flow.
Deleting Registered Model Packages

The metadata entries for registered model packages can be deleted using the SAS Enterprise Miner Client’s View Metadata utility. Access it from the SAS Enterprise Miner Client’s main menu. Select View ⇒ Metadata. Navigate to the MiningResults that you want to delete. If you plan to delete the model package file from the SAS Content Server, it is recommended you note the file path in the properties of your target. To display the properties right-click your target and select Open. To delete the entry, right-click your target and select Delete.

The associated model package files in the SAS Content Server can be deleted with the SAS Content Server Administration Console. For details see the SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide section titled Using the SAS Content Server Administration Console.

SAS Enterprise Miner Start Code

You can enter SAS code that you want to run before any SAS Enterprise Miner processing. This code can include any SAS system options, titles, and footnotes, libref and filename statements, or SAS Enterprise Miner macro variables. Use this code to customize your SAS Enterprise Miner session. You should not enter code that runs SAS procedures or other potentially time-consuming operations. In particular, you should avoid the creation of unneeded SAS libraries, which can slow the creation of SAS Enterprise Miner sessions and thus reduce system responsiveness.

There are three types of start code.

- **Workspace Server Autoexec Code** — The default search path used by the SAS system for autoexec.sas is not used by the workspace server. Instead, any SAS statements that you want executed immediately after the Workspace server initializes can be added to autoexec_usermods.sas. This file can be found in your configuration directory, for example C:\SAS\EMTM\Lev1\SASApp\WorkspaceServer\autoexec_usermods.sas. Other options for workspace server configuration are available in the SAS 9.4 Intelligence Platform Application Server Administration Guide.

- **Server Start Code** — Your server administrator manages this code that is executed for all SAS Enterprise Miner users for any server. This code is stored in a SAS code file accessible on the SAS server. The filename and location is entered as Initialization Code on the Options tab of the Logical Workspace Server Properties in the SAS Enterprise Miner plug-in for the SAS Management Console.

- **Project Start Code** — Users can enter code that is executed for any process within the current project. This code is stored in the SAS Enterprise Miner project and is edited through the dialog box for the project.

The order of execution of SAS Enterprise Miner session start code is:

1. Workspace Server Autoexec Code
2. Server Start Code
3. Project Start Code

For details about the available SAS Enterprise Miner macro variables, see the SAS Enterprise Miner 14.2 Reference Help in the SAS Enterprise Miner Client.
Defining Migrated Projects in SAS Enterprise Miner

Note: Your SAS Administrator can provide the location of your SAS Enterprise Miner project, which is required for step 3 below.

To define a migrated project, follow the steps below:

1. Log on to SAS Enterprise Miner.
2. Select New Project.
3. Select the SAS Server where the project is accessible and click Next.

4. Enter the Project Name and SAS Server Directory for your project. For example, if the project name on the old system is Test, then the project name on the new system must be Test. The project must be copied to /home/<userid>/em_projects and the SAS Server Directory must be the restored project root directory. This scenario is displayed in the image below.
Click Next.

5. Click Yes when the Project Exist window appears.

Select a location for the project metadata and click Next.


Your previously created diagram should appear in SAS Enterprise Miner, as shown below.
7. Click the ellipsis button in the **Project Start Code** property to open the Project Start Code window. Verify that your library references (LIBNAME statements) are correct. Close the Project Start Code window.

You are now able to run any diagrams in your project.

---

**Configuring the Locale for Multi-Language Environments**

In some multi-language environments, it might be necessary to configure the SAS Web Infrastructure Platform to start each workspace in the locale that is used by the Enterprise Miner client. This is accomplished using the SAS Preferences Manager. The
SAS Preferences Manager is a web application that provides a central facility for individual users to manage their preferences and settings. For more information, see Preferences Manager in the Administering the SAS Web Infrastructure Platform chapter of SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide, located at http://support.sas.com/documentation/cdl/en/bimtag/65039/HTML/default/viewer.htm.

You can start the SAS Preferences Manager from your web browser by using a URL similar to the following: http://server:port/SASPreferences. An example URL might resemble the following: http://test.na.sas.com:80/SASPreferences for Microsoft Windows. or http://test.na.sas.com:7980/SASPreferences for UNIX.

Log on to the SAS Preferences Manager with your SAS Enterprise Miner account information. In the left selection panel, select **Regional**. This opens the **Regional** preferences on the right side. In the **Regional** preferences, under **User Locale** select your preferred locale. At the bottom of the page select **OK** to save your settings and exit the SAS Preferences Manager.
SAS Enterprise Miner with SAS Lockdown Mode

In SAS Enterprise Miner 14.2, the SAS lockdown feature is supported. This function enables SAS administrators to limit the file and directory access of the SAS servers, such as the workspace server and stored process server, to a user-defined list of approved locations. The directories, and all subdirectories, defined in this list can be accessed by SAS Enterprise Miner users. Any attempts to access locations outside of these locations results in access-denied errors.

In order for users to open existing project or create new projects with lockdown mode enabled, the directory that houses the projects must be included in the lockdown path statement or in the file specified by the lockdown file statement. If the administrator defines a Default Project Location in the SAS Enterprise Miner SMC plug-ins, that location must be specified in the lockdown path statement or in the file specified by the lockdown file statement.

To enable lockdown mode, a SAS Enterprise Miner administrator needs to make both of the following configuration changes:

- In the file `SAS-config-dir\SASApp\sasv9_usermods.cfg`, insert the following:
  ```
  -lockdown
  ```

- In the file `SAS-config-dir\SASApp\appserver_autoexec_usermods.sas`, insert the following:
  ```
  lockdown path="<pathName>";
  LOCKDOWN ENABLE_AMS=<access-method>;
  ```

Here, `<pathName>` represents the location that you want users to have access to. Here is an example:

```
lockdown path="C:\Lockdown";
LOCKDOWN ENABLE_AMS=HTTP;
```

This code enables users to access only the location `C:\Lockdown`. 
Because this feature is an explicit permission granting mechanism, all files that might be accessed must be explicitly specified in the lockdown path. This includes the SAS Enterprise Miner project path, SAS start code, and project start code. Additionally, the path to user’s SSH key must be specified in the lockdown path when using SAS High-Performance Data Mining.

With lockdown mode enabled, when a user browses to any directory not listed in the PATH statement, they will receive the following error message:

Because lockdown mode configuration is handled by the SAS engine, no application service restarts are necessary.
Integrated Windows Authentication


To use IWA, you must follow the configuration instructions provided in SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide. You should pay careful attention to the following two configuration steps:

- Register a Service Provider Name (SPN) with the Windows Active Directory domain controller and obtain a Kerberos Keytab and configure it into the server machine.

  When IWA is used in conjunction with Kerberos, IWA enables the delegation of security credentials. Kerberos is an industry-standard authentication protocol that is used to verify user or host identity. The Kerberos protocol uses strong cryptography so that a client can prove its identity to a server (and vice versa) across an insecure network connection.

- The SAS Enterprise Miner Mid-tier must be configured to support IWA. This can be done during the installation by selecting Use Integrated Windows authentication (single sign-on) in the Integrated Windows Authentication window.

In addition to enabling the IWA setting, there are manual configuration steps that must be completed. Follow the instructions in SAS 9.4 Intelligence Platform: Security Administration Guide to complete the configuration. After all configurations are complete, the SAS Enterprise Miner Log On enables users to select Use Integrated Windows authentication (single sign-on) and use their Windows log on credentials to log on to SAS Enterprise Miner.
SAS Enterprise Miner Mid-tier Server Clustering

SAS Enterprise Miner 14.2 supports the SAS 9.4 Intelligence Platform Mid-tier Server Clustering. The detailed architecture and benefits of this web application cluster is documented in the SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide.

Installing the SAS Enterprise Miner Mid-tier Server as a cluster is not much different from installing it in the standard client/server deployment. The SAS Deployment Wizard installation prompts are unaffected by server clustering.

For example, in the three-machine SAS Enterprise Miner deployment example in this book, you can add an additional SAS Enterprise Miner Mid-tier node to form a two-node SAS Enterprise Miner Mid-tier cluster. To do so, run setup.exe from the original software depot and proceed as if you are completing a standard installation. When you get to the Select Deployment Step and Products to Install window, select Step 3: Middle Tier Node (Optional).
When prompted for the **Metadata Server**, you must specify the same metadata server host name that you specified in the first installation stage. Ensure that all SAS Development Agents are running in all server nodes that are used in the server cluster. This enables the SAS Deployment Wizard to automatically integrate each new machine into the existing deployment as a server cluster member.

You must enter the same passwords specified in the previous installations.

For more information about SAS Mid-tier clustering, see *SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide.*